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REMOTE CONTROL

Remote control (CI-V) information

< CI-V connection

The transceiver’s operating frequency, mode, VFO and memory selection, can be remotely controlled using a PC.

The lcom Communications Interface V (CI-V) controls the transceiver.

Connect the transceiver to a PC with a USB cable (User supplied).

® Make the connection as short as possible. The transceiver may not be recognized by the PC, depending on the
USB cable length.

® When connecting to a USB port on your PC with the USB driver installed, USB (A) and USB (B) are named as
“IC-905 Serial Port A (CI-V)” and “IC-905 Serial Port B.”

® The values that can be set with each command differ, depending on the transceiver version.
See the transceiver’s instruction manual for details.

Right side panel To use the USB cable between the transceiver and a
UUSB Cabll,ed PC, you must first install a USB driver.
(User supplied) (16 The latest USB driver and installation guide can be

downloaded from the lcom website.

@/ [ Carefully read the guide, before installing the driver.

https://www.icomjapan.com/support/

To a USB port To the [USB] port

< Preparing

The lcom Communications Interface V (CI-V) is used for remote control.
To control the transceiver, first set its address, data communication speed, and transceive function.
These settings are set in the Set mode (Refer to the IC-905 Basic manual).

< About the data format

The CI-V system can be written using the following data formats. Data formats differ according to command
numbers. A data area or sub command is added for some commands.

Controller (PC) to IC-905 OK message to controller (PC)
O] @ @ ® 06 ® @
\FE|FE| Ac | E0 | cn | sc | Dataarea | FD | IFE|FE| EO | AC | FB | FD |
T,\ Jﬁ T 05
%, 58 £3 58 J g
03 0@ 28 E&  =eo S 02 w3 x-S
= L0 o Ev 2o SofS C T A9 =90 0O T 5
273 05 =5 25 S © EC ng L3 == o5 » 2
Q x 28 4,8 c©g& TGO SC 0 Q% o X s =239 a X
EE ©8 +eo wE §E © 6% gE EE L8 08 ge
) = Do Cg g% ° 52 ) S0 Q= B = )
o] cs B3 25 g0 = ‘5o 5 TS <35 50
a8 €8 5& Eo 5o @5 5 8 a8 £& ©& 9 -3
Fg 59 g:‘-:- = 8:5: c s 2 B _ ¢
o- 08 28 af w o ocg W
%ﬁ 3 28 £ O
l l l I
\FE[FE| E0 | AC| Cn | Sc | Dataarea | FD | IFE|FE| EO | AC | FA | FD |
O] @ @ ® 06 ® @
IC-905 to controller (PC) NG message to controller (PC)
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Remote control (CI-V) information

<& Command table

Cmd.| Sub cmd. Data Description Cmd.| Sub cmd. Data Description
00 See p. 16. Send the frequency data OE |B0*2 Clear the Select channel setting
(transceive) B1*2 Set as select channel
01 See p. 16. Send the mode data (transceive) ® The previously set number by
02+ Seep.16.  |Read the band edge frequencies Cl-Viis set after turning power
03+ S 16 Read th ting f ON, or “1” is selected if no
; eep. 1o. ead the opera !ng requency selection is performed.
04 See p. 16. Read the operating mode 01~03 Set the channel as a Select channel
05*2 See p. 16. Set the operating frequency (01=SEL1, 02=SEL2, 03=SEL3)
06*2 See p. 16. Set the operating mode B2*2 00 ~03 Set the Select memory scan
07 Select the VFO mode channel
00 Select VFO A (00=ALL, 01=SEL1, 02=SEL2,
03=SEL3)
01 Select VFO B
- DO*? Set Scan resume OFF
A0 Equalize VFO Aand VFO B =
® When the split frequency D3 Set Scan resume ON (Close&Delay)
operation is OFF in the Memory OF 00*! Read Split OFF setting
mode or the Call channel mode, 01*1 Read Split ON setting
FA” (NG) is returned. 111 Read DUP— operation
BO Exchange VFO A and VFO B. 191 Read DUP+ operation
® When the split frequency ” -
operation is OFF in the Memory 13 Read DD Repeater Simplex mode
mode or the Call channel mode, (RPS)
“FA” (NG) is returned. 00*2 Set Split function OFF
08*2 Select the Memory mode 01*2 Set Split function ON
00 00 ~ 00 99 | Select the Memory channel 10*2 Set the simplex operation
(Memory channel: 00 00 ~ 00 99 11%2 Set DUP- operation
Call channel: 00 00 (144C1), s -
00 01 (144C2), 12 Set DUP+ operation
00 02 (430C1), 13*2 Set DD Repeater Simplex mode
00 03 (430C2), (RPS)
00 04 (1200C1), 10* 00~ 12 Send/read the tuning step
00 05 (1200C2), (00=0OFF (10Hz or 1Hz)
00 06 (2400C1), 01=100Hz, 02=500Hz,
00 07 (2400C2), 03=1kHz, 04=5kHz,
00 08 (5600C1), 05=6.25kHz, 06=10kHz,
00 09 (5600C2), 07=12.5kHz, 08=20kHz,
00 10 (10GC1), 09=25kHz, 10=50kHz,
00 11 (10GC2) 11=100kHz, = 12=250kHz)
A0 00 00 ~ 01 00 | Select the Memory group 1* 00 Send/read attenuator OFF setting
(Memory channel group: 10 Send/read 10 dB attenuator setting
0000 ~00 99 ® You can set in the 144/430/1200
Call channel group: 01 00) MHz bands.
09 Memory write 13 00 Speech all data by voice synthesizer
0A Memory copy to VFO (S meter level, frequency, and mode)
0B Memory clear 01 Speech the operating frequency and
0C*1 See p. 17. Read frequency offset S meter level by voice synthesizer
0D*2 See p. 17. Send frequency offset 02 Speech the operating mode by
voice synthesizer
0B 00 Cancel the scan ® The mode is announced after
01 Start a Programmed/memory scan the ongoing speech.
02 Start a Programmed scan 14* |01 00 00 ~ 02 55 | Send/read the AF level
03 Start a 4F scan (00 00=Minimum ~ 02 55=Maximum)
12 Start a Fine programmed scan 02 00 00 ~ 02 55 | Send/read the RF gain level
13 Start a Fine AF scan (00 00=Minimum ~ 02 55=Maximum)
22 Start a Memory scan 03 00 00 ~ 02 55 | Send/read the squelch level
(00 00=Minimum ~ 02 55=Maximum)
23 Start a Select memory scan
o1 Start a Mode Select 06 00 00 ~ 02 55 | Send/read the NR level
- art a Vlode select scan (00 00=0% ~ 02 55=100%)
Ax* Select AF scan span
7 ~02 IN PBT] (PBT1
(x=1~7) (x=1 (£5kHz),  x=2 (£10kHz), 0 0000~0255 E;a;gg:ad [TWIN PBT] (PBT1)
x=3 (+20kHz), x=4 (+50kHz), 00 00= Counter Clockwise ~
=5 (+100kHz), x=6 (£500kHzZ) ( =max. Counter Clockwise
x=o (2 ' - ' 01 28=center ~ 02 55=max. Clockwise)
x=7 (£1MHz))
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Remote control (CI-V) information

¢ Command table

(00=OFF, 01=ON)

Cmd.| Sub cmd. Data Description Cmd.| Sub cmd. Data Description
14* 108 00 00 ~ 02 55 | Send/read [TWIN PBT] (PBT2) 16* |12 01~03 Send/read the AGC time constant
position (01=FAST, 02=MID, 03=SLOW)
(00 00=max. Counter Clockwise ~ 22 00/01 Send/read the Noise blanker
01 28=center ~ 02 55=max. Clockwise) (00=OFF, 01=0N)
09 0000 ~ 02 55 | Send/read CW pitch (5 Hz steps) 40 00/01 Send/read the Noise reduction
(00 00=300 Hz ~ 01 28=600 Hz ~ (00=OFF, 01=0N)
02 552900 Hz) 41 00/01 Send/read the Auto Notch function
0A 00 00 ~ 02 55 [ Send/read the selected band’s RF (00=OFF, 01=ON)
power
(00 00=Minimum ~ 02 55=Maximum) 42 00/01 i)%”_dgl‘flfdotrfoRﬁ)peater tone
0B 00 00 ~ 02 55 | Send/read MIC gain :
(00 00=Minimum ~ 02 55=Maximum) 43 00/01 z%[dérsﬁdot:‘fgﬁ’)‘e squelch
oC 00 00 ~ 02 55 | Send/read keying speed ;
(00 00=6 WPM ~ 02 55=48 WPM) 44 00/01 (S()%rldérsﬁdotrfgﬁ)eech compressor
0D 00 00 ~ 02 55 | Send/read Notch filter setting ’ .
(00 00=max. Counter Clockwise ~ 45 00/01 fSen(tzillread the Monitor [MONI]
01 28=center ~ 02 55=max. Clockwise) (légi (IS)ISF 01=0N)
0E 0000~ 02 55| Send/read the COMP level 46 00/01 Send/read the VOX function
(00 00=0 ~ 02 55=10) (00=OFF, 01=ON)
oF 0000~0255 f’oeg‘égizdégeféza;;:29(')?; setiing 47 00 ~ 02 Send/read the BK-IN function
: - (00=BK-IN OFF, 01=Semi BK-IN ON,
12 00 00 ~ 02 55| Send/read NB level 02=Full BK-IN ON)
=09 ~ = 0,
(00 00=0% ~ 02 55=100%) 48 00/01 Send/read the Manual Notch function
15 00 00 ~ 02 55 | Send/read Monitor audio [MONI] level (00=OFF, 01=ON)
=09 ~ = 0,
(00 00=0% ~ 02 55=100%) 4A 00/01 Send/read the AFC function
16 00 00 ~ 02 55 [ Send/read the VOX gain (00=OFF, 01=ON)
=09 ~ — 0,
(00 00=0% ~ 02 55=100%) 4B 00/01 Send/read the DTCS function
17 00 00 ~ 02 55 [ Send/read the Anti VOX gain (00=OFF, 01=ON)
=09 ~ — 0,
(00 00=0% ~ 02 55=100%) 4F 00/01 Send/read the Twin peak filter
19 00 00 ~ 02 55 | Send/read LCD backlight brightness (00=OFF, 01=ON)
(00 00=0% ~ 02 55=100%) (Can be turned ON only when Mark
15*7 (01 00/01 Read noise or S-meter squelch status and Shift are set to 2125 Hz and
(00=Close, 01=0pen) 170 Hz, respectively)
02 00 00 ~ 02 55 |Read S-meter level 50 00/01 Send/read the Dial Lock function
(00 00=S0, 01 20=89, (00=0OFF, 01=0ON)
02 41=89+60 dB) 56 00/01 Send/read DSP IF filter type in the
05 00/01 Read various squelch (tone squelch, operating band
and so on) status (00=SHARP, 01=SOFT)
(00=Close, 01=Open) 57 00 ~ 02 Send/read the Manual Notch width
07 00/01 Read the OVF status (00=WIDE, 01=MID, 02=NAR)
(00=OVF indicator is OFF, 58 00 ~ 02 Send/read SSB transmit bandwidth
01=0VF indicator is ON) (00=WIDE, 01=MID, 02=NAR)
11 00 00 ~ 02 55 | Read the Po meter level (One of following values is applied,
(00 00=0% ~ 01 43=50% ~ depending on the “COMP” status
02 13=100%) (ON or OFF):
12 00 00 ~ 02 55 | Read SWR meter level WIDE (Command: 1A05 00 17),
(00 00=SWR1 _0‘ 00 48=SWR1.5, MID (Command: 1A05 00 18), or
00 80=SWR2.0, 01 20=SWR3.0) NAR (Command: 1A05 00 19))
13 00 00 ~ 02 55 |Read ALC meter level 5B 00 ~ 02 Sgnd/read the DSQL (Qigital Call
(00 00=Minimum ~ 01 20=Maximum) Slgn IS(;]]U6|C:’:.)/CSQL (Dlglta| Code
14 00 00 ~ 02 55| Read COMP meter level (sgflenfo()j::[ﬁ
(00 00=0 dB ~ 01 30=15dB ~ _ _ -
02102255 d8) 5C 00 ~ 02 S ; d?FF’dot1h Dc;SF(?sL‘T()J(2 C:QL)
15+ 00 00 ~ 02 55 |Read Vb meter level (O%r;orl‘:; O1oD.PRS. 02 NME "
(00 00=0V ~ 00 40=5V ~ 02 41=30 V) = 00~03 Send/ <;|th = S’ o funci
16 00 00 ~ 02 55| Read Ip meter level ' enciread e “one Squeien unction
06 ~ 09 (00=0OFF, 01=TONE, 02=TSQL,
(00 00=0 A~0121=2A~0241=4 A) 03=DTCS, 06=DTCS (T)
16* |02 00/01 Send/read the Preamp ’ '

07=TONE (T)/DTCS (R),
08=DTCS (T)TSQL (R),
09=TONE (T)/'TSQL (R))
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Remote control (CI-V) information

¢ Command table

Cmd.| Sub cmd. Data Description Cmd.| Sub cmd. Data Description
17*3 See p. 17. Send CW messages 1A* |05 |SET > Tone Control/TBW
18 |00 Turn OFF the transceiver 00|18 [00~10 TX > SSB >
01*4 Turn ON the transceiver Send/read TX Tone (Treble) level
19*" |00 Read the transceiver ID (00=-5 ~ 10=+5)
00|19 ([Seep. 20. TX>SSB >
1A* .
00 ::3 P 18 |Send/read memory contents Send/read TX bandwidth for wide
. . 00|20 |[See p. 20. TX>SSB >
01 See p. 19. Send/read band stacking register Sendiread TX bandwidth for mid
contents s s
00|21 ee p. 20. TX > SSB >
*5
02 See p. 20. Send/read memory keyer.conte.nts Send/read TX bandwidth for narrow
03 See p. 20. Send/read the selected IF filter width 00|22 |See p. 20. TX > SSB-D >
04 See p. 20. Send/read the selected AGC time Send/read TX bandwidth
constant 00|23 |00~ 10 TX > AM >
05 |SET > Tone Control/TBW Send/read TX Tone (Bass) level
00|01 |[Seep. 20. RX > SSB > (00=-5 ~ 10=+5)
Send/read RX HPF/LPF settings 00|24 [00~10 TX >AM >
00|02 (00~10 RX > SSB > Send/read TX Tone (Treble) level
Send/read RX Tone (Bass) level (00=-5 ~ 10=+5)
(00=-5 ~ 10=+5) 00(25 |00~ 10 TX > FM >
00|03 (00~ 10 RX > SSB > Send/read TX Tone (Bass) level
Send/read RX Tone (Treble) level (00=-5 ~ 10=+5)
(00=-5 ~ 10=+5) 00|26 |00~ 10 TX>FM >
00(04 ([See p.20. RX > AM > Send/read TX Tone (Treble) level
Send/read RX HPF/LPF settings (00=-5 ~ 10=+5)
00|05 (00~10 RX >AM > 00|27 [00~10 TX>DV >
Send/read RX Tone (Bass) level Send/read TX Tone (Bass) level
(00=-5 ~ 10=+5) (00=-5 ~ 10=+5)
00|06 (00~ 10 RX > AM > 00|28 (00~ 10 TX>DV >
Send/read RX Tone (Treble) level Send/read TX Tone (Treble) level
(00=—5 ~ 10=+5) (00=-5 ~ 10=+5)
00|07 |[See p.20. RX>FM > 00|29 [00~10 TX > ATV >
Send/read RX HPF/LPF settings Send/read TX Tone (Bass) level
00|08 |00~ 10 RX > FM > (00=-5 ~ 10=+5)
Send/read RX Tone (Bass) level 00|30 (00~10 TX > ATV >
(00=-5 ~ 10=+5) Send/read TX Tone (Treble) level
00{09 [00~10 RX > FM > (00=-5 ~ 10=+5)
Send/read RX Tone (Treble) level SET > Function
(00=-5 ~ 10=+5) 00[31 |00 00 ~ 02 55|Send/read the Beep Level setting
00(10 |[See p. 20. RX>DV > (00 00=Minimum ~ 02 55=Maximum)
Send/read RX HPF/LPF settings 00{32 {00/01 Send/read the Beep Level Limit
00|11 (00~ 10 RX>DV > setting
Send/read RX Tone (Bass) level (00=0OFF, 01=0ON)
(00=-5 ~ 10=+5) 0033 |00/01 Send/read the Beep (Confirmation)
00(12 (00~10 RX>DV > setting
Send/read RX Tone (Treble) level (00=0OFF, 01=0ON)
(00=-5 ~ 10=+5) 00|34 |00/01 Send/read the Home CH Beep
0013 (00~10 RX >AM > setting
Send/read RX Tone (Bass) level (00=OFF, 01=0ON)
(00=-5 ~ 10=+5) 00|35 |00~ 03 Send/read the Band Edge Beep
00|14 (00~10 RX >AM > setting
Send/read RX Tone (Treble) level (00=0FF, 01=ON (Default),
(00=—5 ~ 10=+5) 02=ON (User),
Send/read RX HPF/LPF settings 00|36 |00/01 Send/read the FM/DV Center Error
00[16 |Seep.20. |RX>RTTY> setting
Send/read RX HPF/LPF settings (O0=OFF, 01=ON)
00l17 loo~10 TX > SSB > 00|37 (00~ 04 Seqd/read the Auto Power OFF
Send/read TX Tone (Bass) level setting . .
(00==5 ~ 10=+5) (00=OFF,.01=30 min, 02=60 min,
03=90 min, 04=120 min)
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Remote control (CI-V) information

¢ Command table

Cmd.| Subcmd. | Data Description Cmd.| Subcmd. Data Description
1A* |05 |SET > Function 1A* |05 |SET > Function
00|38 (00~ 05 Send/read the TX Delay (144M) 00|55 [00/01 SPEECH >
setting Send/read the Alphabet setting
(00=0OFF, 01=10 ms, 02=15 ms, (00=Normal, 01=Phonetic Code)
03=20 ms, 04=25 ms, 05=30 ms) 00156 |00/01 SPEECH >
00(39 (00~05 Send/read the TX Delay (430M) Send/read the SPEECH Speed setting
setting (00=Slow, 01=Fast)
(00=OFF, 01=10 ms, 02=15 ms, 00|57 |00~02 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the RX Call Sign
00(40 (00 ~05 Send/read the TX Delay (1200M) SPEECH setting
setting (00=OFF, 01=ON (Kerchunk),
(00=OFF, 01=10 ms, 02=15 ms, 02=ON (All))
03=20 ms, 04=25 ms, 05=30 ms) 00|58 |00/01 SPEECH >
00|41 (00 ~05 Send/read the TX Delay (2400M) Send/read the RX>CS SPEECH setting
setting (00=0OFF, 01=0ON)
(00=OFF, 01=10 ms, 02=15ms, 00/59 |00/01 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the MIC Up/Down
00|42 (00 ~05 Send/read the TX Delay (5600M) SPEECH setting
setting (00=0OFF, 01=0ON)
(00=OFF, 01=10 ms, 02=15 ms, 00|60 |00/01 SPEECH >
03=20 ms, 04=25 ms, 05=30 ms) Send/read the S-Level SPEECH setting
00|43 (00~ 05 Send/read the TX Delay (10G) (00=0OFF, 01=0ON)
setting 00(61 |00/01 SPEECH >
(00=0OFF, 01=10 ms, 02=15 ms, Send/read the MODE SPEECH setting
03=20 ms, 04=25 ms, 05=30 ms) (00=OFF, 01=0N)
00|44 (00 ~05 Send/read the Time-Out Timer 00|62 |00 00~ 0255|SPEECH >
setting Send/read the SPEECH Level setting
(00=OFF, 01=3 min, 02=5 min, (00 00=0% ~ 02 55:100%)
03=10 min, 04=20 min, 05=30 min) 00/63 |00/01 Send/read the [SPEECH/LOCK]
00(45 (00/01 Send/read the PTT Lock setting Switch setting
(00=OFF, 01=0N) (00=SPEECH/LOCK,
00|46 [00/01 SPLIT > 01=LOCK/SPEECH)
Send/read the Quick SPLIT setting 00|64 |00/01 Send/read the Lock Function setting
(00=0FF, 01=0N) (00=MAIN DIAL, 01=PANEL)
00147 |Seep.20.  |SPLIT> 00|65 |00/01 Send/read the Memo Pad Quantity
Send/read the SPLIT Offset setting setting
00|48 [00/01 SPLIT > (00=5 ch, 01=10 ch)
Send/read the SPLIT LOCK setting 00|66 |00/01 Send/read the Function of Touch
(00=OFF, 01=0N) for 1 sec MHz Digits setting
00|49 (00/01 Send/read the Auto Repeater setting (00=Band Stacking Register,
(00=OFF, 01=ON (DUP), 01=1 MHz Step Tuning)
02=ON (DUP,TONE)) 00|67 |00 ~02 Send/read the MAIN DIAL Auto TS
00|50 (00 ~02 Send/read the RTTY Mark setting
Frequency setting (00=0FF, 01=Low, 02=High)
(00=1275 Hz, 01=1615 Hz, 00|68 |00/01 Send/read the MIC Up/Down Speed
02=2125 Hz) setting
00|51 (00~ 02 Send/read the RTTY Shift Width (00=Slow, 01=Fast)
setting 00|69 |00/01 Send/read the AFC Limit setting
(00=170 Hz, 01=200 Hz, 02=425 Hz) (00=OFF, 01=0N)
00|52 |00/01 Send/read the RTTY Keying 00|70 |00~ 02 Send/read the [NOTCH] Switch
Polarity setting (SSB) setting
(00=Normal, 01=Reverse) (00=Auto, 01=Manual, 02=Auto/Manual)
00153 100 ~06 Send/read the ATV Audio Sub 00|71 |00~02 Send/read the [NOTCH] Switch
Carrier Frequency setting (AM) setting
%g?gﬁ(ﬁ: =‘(‘j)f "é”‘s'zl\!ﬂs'2=5-5 MHz, (00=Auto, 01=Manual, 02=Auto/Manual)
=6. z, 04=6. z,
05=7.02 MHz, 06=7.2 MHz) 00|72 [00/01 Send/read the SSB/CW _
Synchronous Tuning setting
00|54 [00/01 SPEECH > (00=OFF, 01=ON)
Sen.d/read the SPEECH Language 00|73 [00/01 Send/read the CW Normal Side setting
setting 00=LSB, 01=USB
(00=Japanese, 01=English) (00=LSB, 01=USB)
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Remote control (CI-V) information

¢ Command table

Cmd.| Subcmd. | Data Description Cmd.| Subcmd. Data | Description
1A* |05 |SET > Function 1A* |05 |SET > DV/DD
00|74 (00/01 Send/read the Power OFF Setting 00|96 (00 ~02 Send/read the Auto Reply setting
(for Remote Control) setting (00=OFF, 01=0ON, 02=\Voice)
(00=Shutdown only, 00|97 |00/01 Send/read the DV Data TX setting
01=Standby/Shutdown) (00=PTT, 01=Auto)
00|75 |[Seep.22. Front Key Customize > 00/98 |00/01 DV Fast Data >
[VOX/BK-IN] setting Send/read the Fast Data setting
00|76 ([Seep.22. Front Key Customize > (00=0OFF, 01=0ON)
[AUTOTUNE/RX>CS/AFC] setting 00|99 [00/01 DV Fast Data >
00|77 |[Seep.22. Send/read the [A] setting Send/read the GPS Data Speed setting
00|78 |See p.22. Send/read the [B] setting (00=Slow, 01=Fast)
00|79 [Seep.22. |Sendiread the [A] setting 01100 {00 ~10 gV g/ast(?;taix Delay (PTT) satt
- end/read the elay setting
00(80 ([Seep.22. Send/read the [V] setting (00=OFF, 01=1sec ~ 10=10sec)
00|81 100/01 ggg‘;t:tm'g Key > Mode Select > 01]o1 [00~02 Send/read the Digital Monitor setting
(00=OFF. 01=0N) 01/02 |00/01 (so 0=d/juto;10;=lglg I't al|’ 22=Analog)
00|82 [00/01 Remote MIC Key > Mode Select > sstr:ingrea the Digital Repeater Set
CW setting _ _
(00=OFF, 01=01) 01(03 |00/01 (SOO d(/)FFc; (t)h1 |(3)\’/\l 2\ to Detect setti
00(83 |00/01 Remote MIC Key > Mode Select > endiread the DV Auto Detect setting
. (00=0OFF, 01=0ON)
RTTY setting
(00=OFF, 01=ON) 01|04 (00/01 Send/read the RX Record (RPT) setting
00|84 |00/01 Remote MIC Key > Mode Select > (00=ALL, 01=Latest Only)
AM setting 01|05 [00/01 Send/read the BK setting
(00=0OFF, 01=0ON) (00=0FF, 01=0ON)
00(85 |[00/01 Remote MIC Key > Mode Select > 01|06 |[00/01 Send/read the EMR setting
FM setting (00=0OFF, 01=0ON)
(00=0FF, 01=0ON) 01|07 |00 00 ~ 02 55 [ Send/read the EMR AF Level setting
00|86 [00/01 Remote MIC Key > Mode Select > (00 00=0% ~ 02 55=100%)
DV setting 01|08 [00/01 Send/read the DD TX Inhibit
(00=0OFF, 01=0ON) (Power ON) setting
00|87 |00/01 Remote MIC Key > Mode Select > (00=OFF, 01=0N)
DD setting 01(09 (00/01 Send/read the DD Packet Output
(00=0OFF, 01=0ON) setting
00|88 [00/01 Remote MIC Key > Mode Select > (00=Normal, 01=All)
ATV setting SET > QSO/RX Log
(00=0FF, 01=0N) 01/10 |00/01 Send/read the QSO Log setting
00|89 (00/01 Send/read the Keyboard Type setting (00=0OFF, 01=0ON)
(00=Ten-key, 01=Full Keyboard) 01|11 [00/01 Send/read the RX History Log setting
00|90 (00 ~02 Send/read the Full Keyboard Layout (00=OFF, 01=0ON)
sefting 01[12 |00~ 02 CSV Format >
(00=English, 01=German, Send/read the Separator/Decimal
02=French) setting
00({91 (00/01 Send/read the Screen Capture (00=Separator is “, " and Decimal is “ .,
[POWER] Switch setting 01=Separator is “; " and Decimal is . ,”
(00=OFF, 01=0ON) 02=Separator is “; " and Decimal is “, )
00|92 (00/01 Send/read the Screen Capture File 01|13 (00 ~02 CSV Format >
Type setting Send/read the Date setting
(00=PNG, 01=BMP) (00="yyyy/mm/dd,” 01="mm/dd/yyyy,”
00|93 |00 00 ~ 02 55 | Send/read the REF Adjust setting 02="dd/mm/yyyy")
(00 00=0% ~ 02 55=100%) SET > Connectors
00|94 |00 00 ~ 02 55|Send/read the REF Adjust (FINE) 01|04 [00/01 Send/read the Speaker MIC AF
setting Output setting
(00 00=0% ~ 02 55=100%) (00=0OFF, 01=0ON)
SET > DV/DD 0115 (00~ 02 Send/read the SP Jack Function setting
00(95 |00~03 Send/read the Standby Beep setting (00=Speaker, 01=Phone,
(00=0OFF, 01=0N, 02=Phone (L+R))
02=0ON (to me:High Tone), 01|16 (00 ~30 Send/read the Phones Level setting
03=0ON (to me:Alarm/High Tone)) (00=-15 ~ 30=+15)
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Cmd.| Sub cmd. | Data Description Cmd.| Sub cmd. Data Description
1A* |05 |SET > Connectors 1A* |05 |SET > Connectors
01|17 [00/01 USB/AV-OUT AF/IF Output > 01|35 [00/01 SEND Output >
Send/read the Output Select setting Send/read the 10G setting
(00=AF, 01=IF) (00=0FF, 01=0ON)
01[18 {00 00 ~ 02 55 [USB/AV-OUT AF/IF Output > 01|36 (00~ 04 USB SEND/Keying >
Send/read the AF Output Level Send/read the USB SEND setting
setting (00=OFF, 01=USB (A) DTR,
(00 00=0% ~ 02 55=100%) 02=USB (A) RTS, 03=USB (B) DTR,
01[19 |00/01 USB/AV-OUT AF/IF Output > 04=USB (B) RTS)
Send/read the AF SQL setting ® You cannot select the terminal
(00=OFF (Open), 01=ON) which is already selected in the

“USB Keying (CW)” or “USB

01|20 |00/01 USB/AV-OUT AF/IF Output > ) "
Send/read the AF Beep/Speech... Keying (RTTY)" item.
Output setting 01|37 (00~ 04 USB SEND/Keying >
(00=OFF, 01=0ON) Send/read the USB Keying (CW)

setting

(00=OFF, 01=USB (A) DTR,
02=USB (A) RTS, 03=USB (B) DTR,
04=USB (B) RTS)

® You cannot select the terminal

01|21 (00 00 ~ 02 55| USB/AV-OUT AF/IF Output >
Send/read the IF Output Level
setting

(00 00=0% ~ 02 55=100%)

01)22 100/01 LAN AF/IF Output > which is already selected in the
Send/read the Output Select setting “USB SEND” item.
(00=AF, 01=IF) 01(38 (00~ 04 USB SEND/Keying >
01/23 |00/01 LAN AF/IF Output > Send/read the USB Keying (RTTY)
Send/read the AF SQL setting setting
(00=OFF (Open), 01=0ON) (00=OFF, 01=USB (A) DTR,
01|24 |00 00 ~ 02 55|MOD Input > 02=USB (A) RTS, 03=USB (B) DTR,
Send/read the USB MOD Level setting 04=USB (B) RTS)
(00 00=0% ~ 02 55=100%) ® You cannot select the terminal
01|25 |00 00 ~ 02 55 |MOD Input > which is already selected in the
Sendiread the LAN MOD Level setting “USB SEND" item.
(00 00=0% ~ 02 55=100%) 01|39 |00/01 External Keypad >
01126 |00~03 MOD Input > Send/read the VOICE setting
Sendlread the DATA OFF MOD setting (00=0FF, 01=0N)
(00=MIC, 01=USB, 01|40 (00/01 External Keypad >
02=MIC, USB, 03=LAN) Send/read the KEYER setting
01/27 |00~03 MOD Input > (00=0FF, 01=ON)
Send/read the DATA MOD setting 01|41 [00/01 External Keypad >
(00=MIC, 01=USB, Send/read the RTTY setting
02=MIC, USB, 03=LAN) (00=OFF, 01=0ON)
01|28 (00 00 ~ 02 55|MOD Input > 01|42 (00/01 Cl-V >
Send/read the AV-IN MOD Level Send/read the Cl-V Transceive setting
setting (00=0OFF, 01=0ON)
(00 00=0% ~ 02 55=100%) 01143 |00/01 Cl-V >
01|29 (00~ 05 MOD Input > Send/read the CI-V USB Echo Back
Send/read the ATV MOD setting setting
(00=MIC, 01=AV-IN, 02=MIC, AV-IN, (00=OFF, 01=0ON)
03=USB, 04=MIC, USB, 05=LAN) 01[44 |00 ~03 USB (B) Function >
01(30 (00/01 SEND Output > Send/read the USB (B) Function
Send/read the 144M setting setting
(00=OFF, 01=0ON) (00=OFF, 01=RTTY Decode,
01(31 |00/01 SEND Output > 02=DV Data, 03=Weather)
Send/read the 430M setting 01|45 (00/01 USB (B) Function >
(00=0OFF, 01=0ON) Send/read the GPS Out setting
01(32 |00/01 SEND Output > (00=OFF, 01=ON)

@ ltis valid when “USB (B) Function”

Send/read the 1200M setting is set {0 “OFF” or “DV Data.”
i .

(00=OFF, 01=ON)

01/33 |00/01 SEND Output > 01(46 |00/01 Send/read Fhe MIC Jack 8V
Send/read the 2400M setting Outlout settmg
(00=0OFF, 01=0N) (00=0FF, 01=0ON)

01/34 |00/01 SEND Output > 01147 |00/01 Send/read the REF OUT setting

(00=Auto (CX-10G:ON), 01=ON)

Send/read the 5600M setting
(00=0FF, 01=0ON)
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Cmd.| Subcmd. | Data | Description Cmd.| Subcmd. Data Description
1A* |05 |SET > Display 1A* |05 |SET > Display
01[48 (00 00 ~ 02 55|Send/read the LCD Backlight setting 01(68 [00/01 Display Unit >
(00 00=0% ~ 02 55=100%) Send/read the Altitude/Distance setting
01|49 [00/01 Send/read the LCD Backlight Auto (00=m, 01=ft/mi)
Adjust setting 01|69 (00 ~02 Display Unit >
(00=0OFF, 01=0ON) Send/read the Speed setting
01/50 |00~ 06 Send/read the Screen Saver setting (00=km/h, 01=mph, 02=knots)
(00=OFF, 01=1min, 02=2min, 01|70 [00/01 Display Unit >
03=5min, 04=15min, 05=30min, Send/read the Temperature setting
06=60min) (00=°"C, 01="F)
01|51 [00/01 Send/read the Screen OFF 01|71 (00 ~03 Display Unit >
[POWER] Switch setting Send/read the Barometric setting
(00=0OFF, 01=0ON) (00=hPa, 01=mb, 02=mmHg, 03=inHg)
01(52 (00/01 Send/read the Meter Peak Hold setting 01(72 |(00/01 Display Unit >
(00=0OFF, 01=0ON) Send/read the Rainfall setting
01|53 |00/01 Send/read the Multi-func. Meter (00=mm, 01=inch)
Voltage Display setting 01(73 (00~03 Display Unit >
(00=DC IN, 01=VD) Send/read the Wind Speed setting
01|54 |00/01 Send/read the Memory Name setting (00=m/s, 01=km/h, 02=mph, 03=knots)
(00=OFF, 01=0ON) 01|74 (00/01 Send/read the Display Language setting
01/55 |00/01 Send/read the Group Name Popup (00=English, 01=Japanese)
setting 01|75 [00/01 Send/read the System Language setting
(00=0OFF, 01=0ON) (00=English, 01=Japanese)
01|56 (00~ 03 Send/read the RX Call Sign Display SET > Time Set
setting 01[76 |20 20 0101 ~|Date/Time >
(00=OFF, 01=Normal, 20991231 |Send/read the Date setting
02=RX Hold, 03=Hold) (20 20 01 01=2020/1/1 ~
01|57 [00/01 Send/read the RX Position Indicator 20 99 12 31=2099/12/31)
setting 01|77 |00 00 ~ 23 59 | Date/Time >
(00=CFF, 01=ON) Send/read the Time setting
01|58 [00/01 Send/read the RX Position Display (00 00=00:00 ~ 23 59=23:59)
setting 01|78 |00/01 Date/Time >
(00=OFF, 01=ON) Send/read the NTP Function setting
0159 (00~ 04 Send/read the RX Position Display (00=0OFF, 01=0ON)
Timer setting 01]79 |Seep.19. Date/Time >
(00=5sec, 01=10sec, 02=15sec, Send/read the NTP Server Address
03=30sec, 04=Hold) setting
01(60 [00/01 Send/read the Reply Position (Up to 64 characters)
Display setting 01|80 |00/01 Date/Time >
(00=OFF, 01=0N) Send/read the GPS Time Correct
01|61 [00/01 Send/read the RX Picture Indicator setting
setting (00=OFF, 01=Auto)
(00=CFF, 01=ON) 01|81 [Seep.21. |Send/read the UTC Offset setting
01|62 [00/01 Send/read the DV RX Backlight setting SET > SD Card
(00=OFF, 01=ON) o01/82 |00~ 02 Import/Export > CSV Format >
01|63 (00~ 02 Seqd/read the TX Call Sign Display Send/read the Separator/Decimal
setting . setting
(00=OFF, 01=Y°U" Call Sign, (00=Separator is “, ” and Decimal is “ . ,”
02=My Call Sign) 01=Separator is “ ; ” and Decimal is “ . ,”
01(64 (00/01 Send/read the Scroll Speed setting 02=Separator is “ ; " and Decimal is “, ")
(00=Slow, 01=Fast) 01|83 [00~02 Import/Export > CSV Format >
01|65 [00/01 Send/read the Opening Message setting Send/read the Date setting
(00=0OFF, 01=0ON) (00="yyyy/mm/dd,” 01="mm/dd/yyyy,”
01|66 |00/01 Send/read the Power ON Check setting 02="dd/mm/yyyy")
(00=0OFF, 01=0ON) SCOPE > SCOPE SET
01|67 (00 ~02 Display Unit > 01|84 (00/01 Send/read the Scope during Tx
Send/read the Latitude/Longitude (CENTER Type) setting
setting (00=0OFF, 01=0ON)
(00=ddd*mm.mn7, 01=ddd"mm’ss", 01/85 |00 ~02 Send/read the Max Hold setting
02=ddd.dddd") (00=OFF, 01=10s Hold, 02=ON)
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Cmd.| Sub cmd. | Data Description Cmd.| Sub cmd. Data Description
1A* |05 |SCOPE > SCOPE SET 1A* |05 |SCOPE > SCOPE SET
01|86 (00~ 02 Send/read the CENTER Type 02|11 [Seep. 21. Fixed Edges > 2400M >
Display setting Send/read the No.1 setting
(g?zg“ef C?D“t_ertv Cont 02[12 |Seep.21. |Fixed Edges > 2400M >
=tarrier Foint Lenter, Send/read the No.2 settin
02=Carrier Point Center (Abs. Freq.)) 0213 |See p. 21 Fixed Edges > 2400M > g
01|87 |00/01 Send/read the Marker Position " | sendiread the No.3 setting
(FIX Type/SCROLL Type) setting .
(00=Filter Center, 01=Carrier Point) 02|14 |Seep. 21. gz:j/ri‘;%eti: ﬁiofz’;mg
0188 ) 00/01 ﬁ‘)%ldéf:gvthgi E\;,:,/Ydsee)’tt'”g 02[15 |Seep.21. |Fixed Edges > 5600M >
: - - Send/read the No.1 setting
01189 100~03 i)%n:dg,fﬁdotr sz‘ézrfg'%%iit)t'"g 02|16 |Seep.21. |Fixed Edges > 5600M >
: : : - Send/read the No.2 setting
01190 100/01 foegfgia%ff,:\rl\ﬁﬁ:;r;n Type setting 02|17 |Seep.21. |Fixed Edges > 5600M >
: Send/read the No.3 setting
01|91 [Seep.21. (Sce:l-dr;rsta;\cis;Tt?n\gVaveform Color 02]18 |Seep. 21, Fixed Edges > 5600M >
Send/read the No.4 setting
01|92 [Seep.21. (SLei:g)/rse:t(tjir:Ze Waveform Color 0219 |seep. 21, Fixed Edges > 10G >
Send/read the No.1 setting
01|93 [Seep. 21. (S,\j;\g/;eoa;g)t:;ﬁwnzveform Color 02]20 |Seep. 21, Fixed Edges > 10G >
- - Send/read the No.2 setting
o (S()eg:g?g tg;E:WOa,;e)l‘fa” Pisplay sting 02|21 |Seep. 21. Fixed Edges > 10G >
: - Send/read the No.3 setting
01195 100~02 (Soegfgf:x tgil’\,{;ﬁﬁggfﬁzzg sefting 02|22 |Seep.21. |Fixed Edges > 10G >
: : - Send/read the No.4 setting
01|96 (00~ 02 Send/read the Waterfall Size AUDIO > AUDIO SCOPE SET
(Expand Screen) setting
(00=Small, 01=Mid, 02=Large) 02|23 [00/01 Send/read the FFT Scope
01|97 |00 ~o07 Send/read the Waterfall Peak Color Waveform Type setting
Level setting (00=Line, 01=Fill)
(00=Grid1 ~ 07=Grid8) 0224 ([Seep.21. Send/read the FFT Scope
01|98 [00/01 Send/read the Waterfall Marker Waveform Color setting
Auto-hide setting 02|25 (00/01 Send/read the FFT Scope
(00=0OFF, 01=0ON) Waterfall Display setting
0199 [Seep.21. |Fixed Edges > 144M > (00=OFF, 01=ON)
Send/read the No.1 setting 0226 ([Seep.21. Send/read the OsciIIQSCOpe
0200 [Seep.21. |Fixed Edges > 144M > Waveform Color setting
Send/read the No.2 setting VOICE
02|01 |[Seep.21. Fixed Edges > 144M > 02|27 (00 00 ~ 02 55 [ Send/read the TX LEVEL setting
Send/read the No.3 setting (00 00=0% ~ 02 55=100%)
02|02 [Seep.21. |Fixed Edges > 144M > 02|28 |00/01 VOICE TX SET >
Send/read the No.4 setting Send/read the Auto Monitor setting
02]03 [Seep.21. |Fixed Edges > 430M > (00=OFF, 01=0N)
Send/read the No.1 setting 02|29 |01~15 VOICE TX SET > . .
02]04 |Seep.21. Fixed Edges > 430M > Send/read the Repeat Time setting
Send/read the No.2 setting (01=1sec ~ 15=15sec)
02]05 [Seep.21. |Fixed Edges > 430M > R
Send/read the No.3 setting 02|30 (00~ 04 Send/read the Number Style setting
02|06 [Seep.21. |Fixed Edges > 430M > (82:2“;’5"1%\‘0; ‘0139_%—0”*',“\1%
Send/read the No.4 setting 04:90 —I:IT) P DTN
=90—
02|07 |[Seep.21. Fixed Edges > 1200M > ) .
. 0231 (01~08 Send/read the Count Up Trigger setting
Send/read the No.1 setting
_ (01=M1 ~ 08=M8)
02]08 | See p. 21. gzs:/rii%ii; ,liozoi;in o 02|32 |00 01 ~ 99 99 |Send/read Present Number setting
- 00 01=1 ~ 99 99=9999
02|09 ([Seep.21. Fixed Edges > 1200M > KEYER > CW-KEY SET( )
Send/read the No.3 setting '
02110 |See p. 21 Fixed Edges > 1200M > 02|33 (0000 ~ 02 55 [ Send/read Side Tone Level setting
. . =0% ~ = 9
Send/read the No.4 setting (00 00=0% ~ 02 55=100%)
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Cmd.| Subcmd. | Data | Description Cmd.| Subcmd. Data | Description
1A* |05 |KEYER > CW-KEY SET 1A* |05 |RECORD > Recorder Set
02|34 (00/01 Send/read Side Tone Level Limit setting 02|56 [00/01 Send/read the PTT Auto REC setting
(00=0OFF, 01=0ON) (00=0FF, 01=0ON)
0235 (01~60 Send/read Keyer Repeat Time setting 02|57 (00~03 Send/read the PRE-REC for PTT
(01=1sec ~ 60=60sec) Auto REC setting
02|36 |28~45 Send/read Dot/Dash Ratio setting (00=OFF, 01=5sec,
(28=1:1:2.8 ~ 45=1:1:4.5 02=10sec, 03=15sec)
in 0.1 steps) RECORD > Player Set
02|37 (00~03 Send/read Rise Time setting 02|58 (00~03 Send/read the Skip Time setting
(00=2ms, 01=4ms, (00=3sec, 01=5sec,
02=6ms, 03=8ms) 02=10sec, 03=30sec)
0238 |(00/01 Send/read Paddle Polarity setting SCAN > SCAN SET
(00=Normal, 01=Reverse) 02|59 |00/01 Send/read the SCAN Speed setting
0239 (00~02 Send/read Key Type setting (00=Slow, 01=Fast)
(00=Straight, 01=Bug, 02=Paddle) 02|60 [00/01 Send/read the SCAN Resume setting
0240 (00 ~02 Send/read MIC Up/Down Keyer setting (00=0OFF, 01=0ON)
(00=OFF, 01=ON (UP/DOWN), 02|61 |00~10 Send/read the Pause Timer setting
02=ON (A/B)) (00=2sec ~ 09=20sec in 2 seconds,
DECODE > RTTY DECODE SET 10=HOLD)
0241 (00~03 Send/read the FFT Scope Averaging 0262 (00~ 06 Send/read the Resume Timer setting
setting (00=0sec ~ 05=5sec, 06=HOLD)
(00=0FF, 01=2, 02=3, 03=4) 02|63 |00~ 04 Send/read the Temporary Skip
0242 ([Seep.21. Send/read the FFT Scope Timer setting
Waveform Color setting (00=5min, 01=10min, 02=15min,
02|43 |00/01 Sendiread the Decode USOS setting 03=While Scanning,
(00=OFF, 01=ON) 04=While Powered ON)
02144 |00/01 Send/read the Decode New Line 02|64 |(00/01 Send/read the MAIN DIAL Operation
Code setting (SCAN) setting
(OOZOFF, 01 :ON) (00=OFF, 01 =Up/D0wn)
02|45 |00/01 Send/read the TX USOS setting GPS
(00=0FF, 01=0ON) 02|65 [00/01 GPS Set >
02|46 |[Seep.21. Send/read the Font Color (Receive) Send/read the Position Input setting
setting (00=Internal GPS, 01=Manual)
02|47 |Seep.21. |Send/read the Font Color (Transmit) 02166 |00/01 GPS Set > GPS Option >
setting Send/read the SBAS setting
DECODE > RTTY DECODE LOG o7 Toorot gg;o;f’ 0(13=P<:)3NC)) ;
> >
02|48 |00/01 Send/read the Decode Log setting o © ot GLS,\"‘X‘SS "
00=OFF, 01=ON) end/read the setting
( ' (00=OFF, 01=ON)
02149 00/01 ;"gds/et >d the File T " 02|68 |00/01 GPS Set > GPS Option >
endfread the riie Type setling Send/read the Satellite Information
(00=Text, 01=HTML) o )
ut setting
02|50 |00/01 Log Set > (00=GPS/QZSS/GLONASS,
Sen_d/read th_e Time Stamp setting 01=GPS Only)
(00=OFF, 01=ON) 0269 |Seep.21. |GPS Set>
02|51 |00/01 Log Set> . . Send/read the Manual Position setting
Sggﬂ’[ead tlh%:"_“Sngmp (Time) setting 02/70 |00~ 02 Sendiread the GPS TX Mode setting
(00=Local, 01=UTC) (00=OFF, 01=D-PRS, 02=NMEA)
02|52 (00/01 Log Set >
Send/read the Time Stamp Gl RN IMOdeLIDERS
(Frequency) setting 02|71 [Seep.19. Send/read the Unproto Address setting
(00=0OFF, 01=0ON) (Up to 56 characters)
RECORD > Recorder Set 02|72 (00 ~03 Send/read the TX Format setting
02]53 [00/01 Sendiread the TX REC Audio setting (00=Position, 01=Object,
. ) 02=Item, 03=Weather)
(00=Direct, 01= Monitor) EEEp— G —
02|54 [00/01 Send/read the RX REC Condition PS > GPS TX Mode > D-PRS > TX Format > Position
setting 02|73 (00~03 Send/read the Symbol setting
(00=Always, 01=Squelch Auto) (8g=m°-;’ 8;’:20-5
02]55 |00/01 Send/read the File Split setting =No.3, 03=No.4)
(00=OFF, 01=ON) 02|74 |Seepp.19 [Send/read the Symbol No.1 setting
and 21. (2 characters)




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

Cmd.

Sub cmd. |

Data

Description

Cmd.

Sub cmd.

Data

Description

1A*

05

GPS > GPS TX Mode > D-PRS > TX Format > Position

02|75 ([Seepp. 19 Send/read the Symbol No.2 setting
and 21. (2 characters)
02|76 ([See pp. 19 Send/read the Symbol No.3 setting
and 21. (2 characters)
02|77 |[Seepp. 19 Send/read the Symbol No.4 setting
and 21. (2 characters)
02|78 (00~ 42 Send/read the SSID setting
(00= - - -, 01=(- 0),
02=-1~16=-15,
17=-A~ 42=-7)
02|79 (00~03 Send/read the Comment setting
(00=No.1, 01=No.2, 02=No.3, 03=No.4)
0280 ([Seep.19. Send/read the Comment No.1 setting
(Up to 43 characters)
0281 [Seep.19. Send/read the Comment No.2 setting
(Up to 43 characters)
0282 ([Seep.19. Send/read the Comment No.3 setting
(Up to 43 characters)
0283 ([Seep.19. Send/read the Comment No.4 setting
(Up to 43 characters)
0284 (00 ~02 Send/read the Time Stamp setting
(00=OFF, 01=DHM, 02=HMS)
0285 |[00/01 Send/read the Altitude setting
(00=0OFF, 01=0ON)
0286 (00~ 02 Send/read the Data Extension setting
(00=0OFF, 01=Course/Speed,
02=Power/Height/Gain/Directivity)
02|87 (00~09 Send/read the Power setting
(00=0W, 01=1W, 02=4W, 03=9W,
04=16W, 05=25W, 06=36W,
07=49W, 08=64W, 09=81W)
0288 (00~09 Send/read the Height setting
(00=3m, 01=6m, 02=12m, 03=24m,
04=49m, 05=98m, 06=195m,
07=390m, 08=780m, 09=1561m)
0289 (00~09 Send/read the Gain setting
(00=0dB ~ 09=9dB)
0290 (00 ~08 Send/read the Directivity setting
(00=Omni, 01=45°NE, 02=90°E,
03=135°SE, 04=180°S, 05=225°SW,
06=270°W, 07=315°NW, 08=360°N)
GPS > GPS TX Mode > D-PRS > TX Format > Object
0291 [Seep.19. Send/read the Object Name setting
(Up to 9 characters)
02(92 (00/01 Send/read the Data Type setting
(00=Live Object, 01=Kill Object)
02|93 ([See pp. 19 Send/read the Symbol setting
and 21. (2 characters)
0294 ([Seep.19. Send/read the Comment setting
(Up to 43 characters)
0295 ([Seep.21. Send/read the Position setting
02|96 (00 ~02 Send/read the Data Extension setting
(00=0OFF, 01=Course/Speed,
02=Power/Height/Gain/Directivity)
0297 (0000 ~ 03 60 |Send/read the Course setting
(00 00=0° ~ 03 60=360°)
0298 (0000 ~ 18 50 | Send/read the Speed setting

(00 00=0km/h ~ 18 50=1850km/h)

12

1A*

05

GPS > GPS TX Mode > D-PRS > TX Format > Object

02

99

00 ~09

Send/read the Power setting
(00=0W, 01=1W, 02=4W, 03=9W,
04=16W, 05=25W, 06=36W,
07=49W, 08=64W, 09=81W)

03

00

00 ~ 09

Send/read the Height setting
(00=3m, 01=6m, 02=12m, 03=24m,
04=49m, 05=98m, 06=195m,
07=390m, 08=780m, 09=1561m)

03

01

00 ~ 09

Send/read the Gain setting
(00=0dB ~ 09=9dB)

03

02

00 ~ 08

Send/read the Directivity setting
(00=0mni, 01=45°NE, 02=90°E,
03=135°SE, 04=180°S, 05=225°SW,
06=270°W, 07=315°NW, 08=360°N)

03

03

00 ~ 42

Send/read the SSID setting
(00=---, 01=(- 0),
02=-1~16=-15,

17=-A~ 42=-7)

03

04

00/01

Send/read the Time Stamp setting
(00=DHM, 01=HMS)

GP

S > GPS TX Mode >

D-PRS > TX Format > Item

03

05

See p. 19.

Send/read the ltem Name setting
(Up to 9 characters)

03

06

00/01

Send/read the Data Type setting
(00=Live Item, 01=Killed Item)

03

07

See pp. 19
and 21.

Send/read the Symbol setting
(2 characters)

03

08

See p. 19.

Send/read the Comment setting
(Up to 43 characters)

03

09

See p. 21.

Send/read the Position setting

03

10

00 ~ 02

Send/read the Data Extension setting
(00=0OFF, 01=Course/Speed,
02=Power/Height/Gain/Directivity)

03

00 00 ~ 03 60

Send/read the Course setting
(00 00 ~ 03 60=0° ~ 360°)

03

0000 ~ 18 50

Send/read the Speed setting
(00 00=0km/h ~ 18 50=1850km/h)

03

00 ~ 09

Send/read the Power setting
(00=0W, 01=1W, 02=4W, 03=9W,
04=16W, 05=25W, 06=36W,
07=49W, 08=64W, 09=81W)

03

00 ~09

Send/read the Height setting
(00=3m, 01=6m, 02=12m, 03=24m,
04=49m, 05=98m, 06=195m,
07=390m, 08=780m, 09=1561m)

03

00 ~09

Send/read the Gain setting
(00=0dB ~ 09=9dB)

03

00 ~ 08

Send/read the Directivity setting
(00=0Omni, 01=45°NE, 02=90°E,
03=135°SE, 04=180°S, 05=225°SW,
06=270°W, 07=315°NW, 08=360°N)

03

00 ~ 42

Send/read the SSID setting

(00=- - -, 01=(- 0),
02=-1~16=-15,
17=-A~42=-7)

GP

S > GPS TX Mode >

D-PRS > TX Format > Weather

03

18

See pp. 19
and 21.

Send/read the Symbol setting
(2 characters)




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

(00 00=0% ~ 02 55=100%)

13

Cmd.| Subcmd. | Data | Description Cmd.| Subcmd. Data | Description
1A* |05 |GPS > GPS TX Mode > D-PRS > TX Format > Weather 1A* |05 |NB
03|19 (00 ~42 Send/read the SSID setting 03|37 (00 ~09 Send/read the NB DEPTH setting
(00= - - -, 01=(- 0), (00=1 ~ 09=10)
02=-1~16=-15, 03|38 [00 00 ~ 02 55 |Send/read the NB WIDTH setting
17=-A~42=-7) (00 00=1 ~ 02 55=100)
0320 [Seep.19. Send/read the Comment setting VOX
(Up to 43 characters) 03[39 [00~20 Send/read the VOX DELAY setting
03(21 |00 ~02 Send/read the Time Stamp setting (00=0.0s ~ 20=2.0s in 0.1s steps)
(00=OFF, 01=DHM, 02=HMS) 03]40 [00~03 Sendiread the VOICE DELAY setting
GPS > GPS TX Mode > NMEA (OOZOFF, 01=SHORT,
03|22*¢|00/01 GPS Sentence > 02=MID, 03=LONG)
Send/read the RMC setting TX PWR LIMIT
(00=OFF, 01=ON) 03[41 [00/01 Sendlread the TX PWR LIMIT
03|23*6{00/01 GPS Sentence > (144M) function setting
Send/read the GGA setting (00=OFF, 01=0ON)
(00=OFF, 01=ON) 03[42 (0000 ~ 02 55|Send/read the TX PWR LIMIT
03|24*%|00/01 GPS Sentence > (144M) setting
Send/read the GLL setting (00 00=0 ~ 02 55:100)
(00=OFF, 01=ON) 03[43 [00/01 Send/read the TX PWR LIMIT
03|25*6 {00/01 GPS Sentence > (430M) function setting
Send/read the GSA setting (00=OFF, 01=0N)
(00=OFF, 01=ON) 03[44 [00 00 ~ 02 55| Sendiread the TX PWR LIMIT
03265 {00/01 GPS Sentence > (430M) setting
Send/read the VTG setting (00 00=0 ~ 02 55=100)
(00=OFF, 01=ON) 03/45 [00/01 Sendread the TX PWR LIMIT
03|27*¢{00/01 GPS Sentence > (1200M) function setting
Send/read the GSV setting (00=OFF, 01=ON)
=OFF, 01=ON
(00=OFF, 01=ON) 03|46 (00 00 ~ 02 55|Send/read the TX PWR LIMIT
0328 [Seep.19. Send/read the GPS Message setting (1200M) setting
(Up to 20 characters) (00 00=0 ~ 02 55=100)
GPS > GPS Alarm 03|47 |00/01 Send/read the TX PWR LIMIT
03|29 ([Seep.21. Send/read the Alarm Area (Group) (2400M) function setting
setting (00=OFF, 01=ON)
03|30 (00~02 Send/read the Alarm Area (RX/ 03|48 (00 00 ~ 02 55|Send/read the TX PWR LIMIT
Memory) setting (2400M) setting
(00=Limited, 01=Extended, (00 00=0 ~ 02 55=100)
02=Both) 03|49 |00/01 Send/read the TX PWR LIMIT
GPS (5600M) function setting
0331 |00~ 06 Send/read the GPS Auto TX setting (00=OFF, 01=ON)
(00=0OFF, 01=30sec, 02=1min, 03|50 (0000 ~ 02 55|Send/read the TX PWR LIMIT
03=3min, 04=5min, 05=10min, (5600M) setting
06=30min) (00 00=0 ~ 02 55=100)
DTMF > DTMF SET 03(51 [00/01 Send/read the TX PWR LIMIT (10G)
03|32 [00~03 Send/read the DTMF Speed setting function setting
(00=100ms, 01=200ms, (00=0OFF, 01=0ON)
02=300ms, 03=500ms) 03|52 (0000 ~ 02 55|Send/read the TX PWR LIMIT (10G)
VIDEO > VIDEO SET Sggigg 0~ 02552100
03|33 |00 00 ~ 02 55 |Send/read the AV-IN Video Input ( - =100)
Level setting cb
(00 00=0% ~ 02 55=100%) 03(53 [00/01 Send/read the Call Sign Display/
03|34 |00 00 ~ 02 55| Send/read the AV-OUT Video Output Name Display setting
Level setting (00=Call S|gr? Display,
(00 00=0% ~ 02 55=100%) 01=Name Display)
03|35 [00~02 Send/read the View Mode setting GPS Position
(00=Normal, 01=Full, 02=Zoom) 03|54 (00 ~02 Send/read the Compass Direction
NB setting
_ - (00=Heading Up, 01=North Up,
03|36 [00 00 ~ 02 55|Send/read the NB LEVEL setting 02=South Up)




REMOTE CONTROL

Remote control (CI-V) information

¢ Command table

Cmd.| Sub cmd. Data Description Cmd.| Sub cmd. Data Description
1A* |06 See p. 23. Send/read the DATA mode setting 20 03 |00* 00/01 Send/read the Auto DV RX
07 00/01 Send/read the NTP server access GPS/D-PRS data output
(00=Terminate, 01=Initiate) (00=OFF, 01=0N)
08*1 00 ~ 02 Read NTP server access result 01/00 ([See p. 25. Output DV.RX GPS/D-PRS Position
(00=Accessing, or have not for transceive
accessed after Power ON, 0101 [Seep. 25. Output DV RX D-PRS Object status
01=Succeeded, 02=Failed) for transceive
09*! 00/01 Read the OVF indicator status 01]02 ([Seep.26. Output DV RX D-PRS Item status
(00=OFF, 01=0ON) for transceive
0A 00 ~ 02 Send/read the Share Pictures 01/03 ([Seep. 26. Output DV RX D-PRS Weather
function status status for transceive
(00=OFF, 01=ON, 02=ON (Repeat)) 02|00* [See p.25.  |Read Auto DV RX GPS/D-PRS
@ While transmitting the picture Position status
using the DV Fast Data function, 02]01*1|See p. 25.  |Read Auto DV RX D-PRS Object
sends ON even if the status is set
status
to OFF. .
0B 00/01 Sendlread the RPT MONI setting 02102"| See p. 26. Rtefd Auto DV RX D-PRS ltem
(00=OFF, 01=ON) 1 status
1B* |00 See p. 23. Send/read the Repeater tone frequency 02103 See p. 26. SZ?L?SAMO AL
01 See p. 23. Send/read the TSQL tone frequem.:y 04 100 00/01 Send/read Auto DV RX GPS/D-PRS
02 See p. 23. Send/read the DTCS code and polarity message output
07 See p. 23. Send/read the CSQL code (DV mode) (00=0OFF, 01=0ON)
1C |00* 00/01 Send/read the transceiver’s status 01 See p. 26. Output DV RX D-PRS message for
(00=RX, 01=TX) transceive
02 00/01 Send/read the Transmit frequency 02*1 See p. 26. Read Auto DV RX D-PRS message
monitor (XFC) status
(00=CFF, 01=0N) 21* |00 See p. 27. Send/read the RIT frequency
03*1 See p. 16. Read the transmit frequency 01 00/01 Send/read the RIT setting
1E 00*! Read number of available TX (00=0OFF, 01=0ON)
frequency band 02 00/01 Send/read the ATX setting
01+ See p. 16. Read TX band edge frequencies (00=0OFF, 01=0ON)
02*1 Read number of user-set TX 22 00 See p. 27. Set the DV TX data (Up to 30 byte)
frequency band 01 |00* 00/01 Set the Auto DV RX data output
03* See p. 16. Send/read the user-set TX band (00=OFF, 01=0ON)
edge frequencies 01 See p. 27. Set the DV RX data for transceive
1F* 00 See p. 23. SET > My Station > 02* 00/01 SET > DV/DD Set >
Send/read the My Call Sign setting Send/read the DV Data TX setting
01 See p. 23. CS > (00=PTT, 01=Auto)
Send/read the UR, R1, R2 setting 03 00/01 SET > DV/DD Set > DV Fast Data
02 See p. 23. SET > My Station > > Send/read the Fast Data setting
Send/read the TX Message setting (00=0OFF, 01=0ON)
20 00 |00* 00/01*7 Send/read the Auto DV RX Call 04* 00/01 SET > DV/DD Set > DV Fast Data >
signs output Send/read the GPS Data Speed setting
(00=0OFF, 01=0ON) (00=Slow, 01=Fast)
01 See p. 24. Output DV RX Call signs for 05* 00~10 SET > DV/DD Set > DV Fast Data >
transceive Send/read the TX Delay (PTT) setting
02*' |Seep.24. |ReadAuto DV RX Call signs (00=OFF, 01=1sec ~ 10=10sec)
01 |00* 00/01*7 Send/read the Auto DV RX message 23 00" See p. 27. Read the position status
output 01* 00/01 GPS > GPS Set >
(00=0OFF, 01=0ON) Send/read the Position Input setting
01 See p. 24. Output DV RX message for (00=Internal GPS, 01=Manual)
transceive 02* See p. 21. GPS > GPS Set >
02*1 See p. 24. Read Auto DV RX message Send/read the Manual Position setting
02 |oo* 00/01*7 Send/read the Auto DV RX status 24 |00 |00* 00/01 Send/read TX output power setting
output (00=OFF, 01=0ON)
(00=0OFF, 01=0ON) 01 00/01 Set the TX output power for transceive
01 See p. 24. Output DV RX status for transceive (00=OFF, 01=0N)
02*1 See p. 24. Read Auto DV RX status

14
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Remote control (CI-V) information

¢ Command table

Cmd.

Sub cmd.

Data

Description

Cmd.| Sub cmd. Data Description

25*

See p. 27.

Send/read the selected or
unselected VFO frequency

26*

See p. 27.

Send/read the selected or unselected
VFO’s operating mode and filter

27*

00

See p. 28.

Read the Scope waveform data
(Only when “Scope ON/OFF status”
(Command: 27 10) and “Scope wave
data output” (Command: 27 11) are
set to “ON,” outputs the waveform
data to the controller (PC).)

00/01

Send/read the Scope ON/OFF status
(00=0FF, 01=0ON)

00/01

Send/read the Scope wave data
output
(00=0OFF, 01=0ON)

00

Send/read the Main or Sub scope
setting
(00=Main (fixed))

00

Send/read the Single/Dual scope
setting
(00=Single (fixed))

0000 ~0003

Send/read the Scope Center mode,
Fixed mode, SCROLL-C mode, or
SCROLL-F mode setting

(00 00=CENTER mode,

00 01=FIX mode,

00 02=SCROLL-C mode,

00 03=SCROLL-F mode)

See p. 28.

Send/read the Span setting in the
Center mode or SCROLL-C mode
Scope

0001 ~0004

SCOPE > SCOPE SET >
Send/read the Scope Edge
Number setting in the Fixed mode
or SCROLL-F mode

(00 01=Fixed Edges No.1,

00 02=Fixed Edges No.2,

00 03=Fixed Edges No.3,

00 04=Fixed Edges No.4)

00 00/
00 01

Send/read the Scope Hold
function ON/OFF status
(00 00=OFF, 00 01=0ON)

See p. 28.

Send/read the Scope Reference
level setting

00 00 ~ 0002

Send/read the Sweep speed setting
(00 00=FAST, 00 01=MID, 00 02=SLOW)

00/01

SCOPE > SCOPE SET >
Send/read the Scope during Tx
(CENTER TYPE) setting
(00=0FF, 01=0ON)

00 ~02

SCOPE > SCOPE SET >
Send/read the CENTER Type
Display setting

(00=Filter Center,

01=Carrier Point Center,

02=Carrier Point Center (Abs. Freq.))

00 00/
00 01

Send/read the Scope VBW setting
(00 00=NAR, 00 01=WIDE)

See p. 29.

Send/read the Scope Fixed Edge
frequencies

15

27* |20 00/01 SCOPE > SCOPE SET >
Send/read Marker Position (FIX
Type/SCROLL Type) setting

(00=Filter Center, 01=Carrier Point)

Transmit the Voice TX Memory
(00=Stop, 01=T1 ~ 08=T8)

28 |00 00 ~ 08

*(Asterisk) Send/read data

*1 Read only data

*2 Send only data

*3 In the CW mode, if the [PTT] or an external TX switch is ON, or the
Break-in function is ON, a message will be transmitted as CW code
when you send it from your PC.

*4 Sending the power ON command (18 01) turns ON the transceiver
when the transceiver is OFF (Standby/Shutdown).

*5 To insert a counter, first clear the other channel’s counter.

*6 Set at least 1 GPS sentence to ON.
Up to 4 GPS sentences can be set to ON at the same time.

*7 Output setting is automatically set to OFF after turning OFF the
transceiver.

*8 |In the 10 GHz band, the drain voltage can be read only while
transmitting, because the power amplifier control method is different
from other bands.



REMOTE CONTROL

Remote control (CI-V) information

<& Command formats

» Operating frequency * Band edge frequency settings
Command: 00, 03, 05, 1C 03 Command: 02, 1E 01, 1E 03

©
®
©@
®
@
G)

O @ 6 ® 6 ©® 0 6 6 O O @

DX [xix [ xox [ xix [ xix[oix ] o [xx]xixxixxix[xix|xix]2:p[x:x[xix|xix[xix|xix]
I} f
3 o
w0 LR C? 0 o o 0 5
&2 ()] (\T 1 Ii‘, ~— Sy » N] o)} O)CD (\il
> 5 © T & 92 L T < o o T ?Ogmcgo?o’ofc"?‘—'gjg‘?m?zézé?\—‘g
] ! 5 °© T o o £ £ T Ao 1 oPuP 00l X ol P 0ocE
S o S 2 5 & ¥ - 5 2 2 # 8 ZolEdE5:s2 € o EDE 52
5 £ 5 2 5 2 %5 2 5 5 2 5 E 5255080922 § 02508022
= o = N T © T8 (N INTO T £ ©IO25 (N NOCOT
N ® o ¥ I NIT NNZT FE o NONETEINNS § NONETEINNS
I I I NT T NT

s T 88332058383 5 2T288202298 g 2¥8852208

L d Higher ed

® When the 5600 MHz or lower band is selected, the ower edge igher edge
number of digits is ~ Q). * When obtaining the edge number (by command “02”), the
ber of digits is 10 (D ~ ®) When obt the ed ber (b d “02"), th

When the 10 GHz band is selected, the number of digits edge number (D) is not returned.

is 12 (D ~ ®) from 100 GHz to 1 Hz. ® When the 10 GHz band is selected, the each Edge
frequency is 12 digits (6 bytes) from 100 GHz to 1 Hz.
+ Operating mode 206 ®6 606 e OO @ B @

Command: 01, 04, 06 xpexpxeixxx]xxox]2 ol xix]xxxixxixo:x

2 = T “ “
XX | xix IR 1
ESEIESE . ! !
t o)) 0 @ X o)) o X
D0 . . . S ol 090263 el 1 1| 1002631 EC
perating mode (2Filter setting 2 202161 73005 5 201021 7200
k= ] © O ogEE 1} © O ogcEE
00:LSB 07:CW-R 01:FIL1 8 SoCsEuET2008 & OB E2 00
E 525202900, uo 5 0252025900
01:USB 08:RTTY-R 02:FIL2 2 5OB QNP NOOTHN & 5985 qNINTOST RN
o FNPIXEIIE=06 5 FRPIEESIZ=905
: : : 5]
02:AM 17:DV 03:FIL3 g oT¥88002088c0 § 0L¥882229880
03:CW 22:DD* —
04-RTTY 23 ATV Lower edge Higher edge
05:FM — —

* The operating mode can be set when the 1200 MHz or
higher band is selected.
@ Filter setting, (@) can be skipped with command 01. In
that case, “FIL1” is selected with command 01.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* Duplex Offset frequency setting
Command: 0C, 0D

@ @ ®
[ X x| x i x| x x|

Im?mc’l
o Y o 2 ! °
’O,,_,Ooo
S £ B & 5 =
£ o 3 © 2 %
2 © 3 © T 3
T N T N~ N Q1
N I x T == ¥
IOOxEE
*x & o© o o

A unl L S s s

® The 10 MHz digit can be set when the 1200 MHz or
higher band is selected.

» Codes for CW message contents
Command: 17 (Up to 30 characters)
To send CW messages, use the following character

codes.

Character | ASCIll code | Character | ASCII code
0~9 30~39 27
A~Z 41 ~ 5A ( 28
a~z 61 ~7A ) 29

/ 2F = 3D

? 3F + 2B
2E ? 22

- 2D @ 40

, 2C Space 20
3A

® “FF” stops sending CW messages.
® “M is used to transmit a string of characters with no
inter-character space.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* Memory content
Command: 1A 00

OO\ B30  —O@~0— @ @ ® ® — ©®~® —— W~ — — D~ —

Dxx[xexxix|xix]oix|xix]--- |xax|xzx|xaxlxzx|xaxlxzoIxaxlxaxlxaxxzx|xzx|x5x|xax|xax|xaxlj

B —B-B——B-O DB B0 9-6
XXX XXX XX XXX XXX oo [ XXX XX
®, @: Memory group number @9: Digital squelch setting
00 00 ~ 00 99: Memory channel group @®
01 00: Call channel group
3, @: Memory channel numbers T r Fixed

* When Memory channel group is selected, 0=Digital squelch function OFF
00 00 ~ 00 99: 00 ~ 99 1=Digital call sign squelch function ON (DSQL)

* When Call channel group is selected, 2=Digital code squelch function ON (CSQL)
0000, 0001: 144 C1, C2 (©~(®: Repeater tone frequency setting
0002, 0003: 430 C1, C2 (9~@D: Repeater tone frequency setting
00 04, 00 05:1200 C1, C2 ® See “Repeater tone/tone squelch frequency setting.”
00 06, 00 07: 2400 C1, C2 (p- 23)

00 08, 00 09: 5600 C1, C2 )
00 10, 00 11: 10G C1, C2 @~@: DTCS code setting

® See “DTCS code and polarity setting.” (p. 23)

@): DV Digital code squelch setting
® See “DV Digital code squelch setting.” (p. 23)

(®: Split and Select memory setting
®

1= %1 26~@: Duplex offset frequency setting
L 2= %2 ® See “Duplex Offset frequency setting.” (p. 17)
i 3=%3
Fixed 29~B0: UR (Destination) call sign setting
* Set 0 for Call channel. (8 characters, fixed)
@0)~@: R1 (Access repeater) call sign setting
©~(0: Operating frequency setting (8 characters, fixed.)
® See “Operating frequency.” (p. 16) @~62: R2 (Gateway/Link repeater) call sign setting
@, (: Operating mode setting SB characters, fixed) )
® See “Operating mode.” (p. 16) ® See “DV TX call signs setting.” (p. 23)
®: Data mode setting 63~68: Memory name setting (16 characters, fixed)
1 byte data (XX) ® See “Codes for character entries.” (p. 19)
00: Data mode OFF
01: Data mode ON To clear the memory channel contents on 1A 00:
_ (M, @: Memory channel group (00 00 ~ 00 99)
(: Duplex and Tone settings You cannot specify group “01 00” (Call channel
group)
0=OFF 3, @: Memory channel (00 00 ~ 00 99)
: 1=TONE ®: “FF,” ® ~ : None
. 2=TSQL
0=Duplex OFF 3=DTCS
1=Duplex- 4=DTCS(T)
2=Duplex+ 5=TONE(T)/DTCS(R)
3=RPS 6=DTCS(T)/TSQL(R)

| 7=TONE(T)TSQL(R)

® RPS can be set when DD mode is selected, and Duplex
(+, -) can be set when other than DD mode is selected.

18



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

» Codes for character entries * Band stacking register
Command: 1A 00, Command: 1A 01
1A05 0179
0271, 0274 ~ 0277, @ @
0280 ~ 02 83, [ X x| X x|
0291, 0293, 02 94,
0305, 0308, 0320, 0328 NOTE: When sending the contents, the codes, such
as operating frequency and operating mode*, should
- Character codes— Letters and Numbers be added after the frequency band code and the
Character | ASCll code | Character | ASCIl code register code, as shown below.
A7 A1~5A P 61~ 7A * See ® ~ © on “Memory content.” (p. 18)
0~9 30~39
(O: Frequency band codes
- Character codes— Symbols Code | Freq.band | Frequency range (unit: MHz)
Character | ASCll code | Character | ASCIl code 01 144 144.000000 ~  148.000000
! 21 # 23 02 430 430.000000 ~ 450.000000
$ 24 % 25 03 1200 1240.000000 ~ 1300.000000
& 26 \ 5C 04 2400 2300.000000 ~ 2450.000000
? 3F » 22 05 5600 5650.000000 ~ 5925.000000
’ 27 : 60 06 10G 10000.000000 ~ 10500.000000
A 5E + 2B
- 2D * 2A (2: Register codes
/ 2F . 2E Code | Registered number
, 2C : 3A 01 |1 (Display on left side)
; 3B = 3D 02 |2 (Display in center)
< 3C > 3E 03 |3 (Display on Right side)
( 28 ) 29
[ 5B ] oD To read the contents, the register code should be
{ 7B } 7D added after the frequency band code, as shown
| 7C _ 5F below.
- 7E @ 0 Example: When reading the frequency displayed in

the center of the display in the UHF band,
use code “02 02.”
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ Keyer memory character entries + AGC time constant settings
Command: 1A 02 Command: 1A 04
- Character codes Data AGC time constant (sec.)
SSB/CW/RTTY AM
Ch:ra(;ter AS;):II c:;de D::scri:tion 00 OFF OFF
A~Z 41 ~5A En:t . ot 0 03
s - W Z ers 02 0.2 05
pfce o (;r Ssalce 03 0.3 0.8
: - symbo| 04 0.5 12
' e symbo| 05 0.8 16
: = symbo| 06 12 2.0
: o symbo| 07 16 25
e i ym d°_ 08 2.0 3.0
A xample: to send BT,
S5E enter 24254 09 2.5 4.0
. oA Inserts the contest number 10 3.0 5.0
(can be used for 1 channel only) 11 4.0 6.0
12 5.0 7.0
® Information 13 6.0 8.0
* “FA” (NG) is returned if you insert the content number in
more than 1 channel. « RX HPF/LPF setting for each operating mode
+ Spaces after the end of the sentence are not necessary. Command: 1A05 00 01. 00 04. 00 07
+ To clear the Keyer memory contents, send one or more 00 10’ 00 15’ 00 16,
spaces. ’ ’
HPF (Lower edge) J L LPF(Upper edge)
00=Through 05 ~ 24=500~2400 Hz
01 ~20=100 ~ 2000 Hz 25=Through
* Keyer memory content
Command: 1A 02 ® The value of the HPF should be smaller than the LPF.

----- : + SSB/SSB-DATA transmission passband width
..... : settings
Command: 1A05 0019~ 00 22

@ ~ @: Text data
: Channel data Lower edge Higher edge

01=M1 05=M5 ; 0=100 Hz 0=2500 Hz
02=M2 06=M6 Y Lower edge 17200Hz 1= 2700 Hz
03=M3 07=M7 ) 2=300Hz 2=2800Hz
04=M4 08=M8 Higher edge 3=500 Hz 3=2900 Hz
» Split offset frequency setting
« IF filter width settings Command: 1A05 00 47
Command: 1A 03 @ ) ©) @
Mode Data Steps [ x 0 | x x| o x| x x|
SSB/CW/RTTY | 00~09 |50~ 500 Hz (50 Hz) T [ T T I T T
(o)}
SSB/CW 10 ~40 |600 Hz ~ 3.6 kHz (100 Hz) o é C;’ 1! cl': Direction:
RTTY 10 ~31 |600 Hz ~ 2.7 kHz (100 Hz) cla © i © = o 00=+ direction
.y = (o)) = = ] - di .
AM 00 ~49 | 200 Hz ~ 10.0 kHz (200 Hz) £ 2 = 2 2 g 07 directon
o N I NN R
N It Xx T T T
T o ® o x =0 =
= oX oS o o Xz

20



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ UTC Offset setting
Command: 1A05 01 81

X X | x x| x x|
\ I /

Offset time Shift direction

0000 ~ 14 00 00=+ (plus)

01=- (minus)

» Color settings
Command: 1A05 0191, 0192, 0193, 02 24,
02 26, 0242, 0246, 0247
@ @ ® @ ® ®
[0 x[x :x]o x[xix[o:X[x x|
\ /\ /\ /

R (Red) G (Green) B (Blue)
0000~0255 0000~0255 0000 ~0255

+ Bandscope edge frequency settings
Command: 1A05 0199~ 0222

o @ & ® & & © ©® © O

[x o[ xix[xix[xix[ox[x 0 [xix|xix[xix[0ix]
! BEE E
g1 edg] g0 |=d3
E9a0 NTE]l | R 50 T E]

TS2odo 12229932022 0c

o N~ NyOePREPFNyo N yee RN

. NT N T N N II--NINI'N'N II

EIXE§II§OOEI‘“§§IIEQO

¥x88c0020880c¥8800=20880o

L Il |

Lower edge Higher edge

21

* Manually entered position data
Command: 1A05 0269, 02 95, 03 09,
23 02

D2 ®O6 OO MmO DR G G
Dix|xix[xix|x:o]ox]oix|x:x|xix[xix|x:0]o:x|x:x|x:x[x:x[0:X]

1
1

0/East longitude=1—>|

0/North latitude

itt0~9

degree digit: 0 ~ 9

1

0.1 meter digit: 0 ~ 9

0 (Fixed)

meter digit: 0 ~ 9
0/

0.001 minute digit: 0 ~ 9
0000 meter digit: 0 ~ 1

0 (Fixed)

0.01 minute digit: 0 ~ 9
0 (Fixed)

0 minute digit: 0 ~ 5
minute digit: 0 ~ 9
0.1 minute digit: 0 ~ 9

0.001 minute digit: 0 ~ 9
00 degree digit: 0 ~ 1

0 (Fixed)

0.01 minute digit: 0 ~ 9
0 (Fixed)

10 degree digit: 0 ~ 9
1 degree digit: 0 ~ 9
10 minute digit: 0 ~ 5
1 minute digit: 0 ~ 9
0.1 minute digit: 0 ~ 9
South latitude:
0 (Fixed)

0 degree d
West longitude

+=

—_ - ~—

Latitude

® ~ ®: Latitude (dd°mm.mmm format)

(® ~ (): Longitude (ddd°’mm.mmm format)

@ ~ @9: Altitude (0.1 meter steps)

* When reading the contents with no altitude, sends (2, 3,

@, and @ as “FF.”
* When sending the contents with no altitude, set (2, (3, (3,
and @ to “FF.”

Lonaitude Altitude

* D-PRS Symbol setting
Command: 1A05 0274 ~0277, 0293,

03 07, 0318
| x x| x @ x|
4 Ao
First digit Second digit

*/\,0t0 9, Ato Z can be used for the first digit
character.

» See “Codes for character entries” for the second
digit character. (p. 19)

+ Alarm area (Group) setting
Command: 1A05 0329

® @) ®

[ x x| xix][x:o|

IR

()]

o) @ t

T o 1 & ©°

o l o = 5

> £ 2 B O
T 2 ° ¢ £ 4
s 2 £ € E 3
E £ & - 35 X
o E = o o &
-~ - O o o o



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ [VOX/BK-IN] setting * Remote MIC Key setting
Command: 1A05 0075 Command: 1A05 0077 ~ 00 80
Data Function Data Function
00 TRANSMIT 00 No function
01 VOX/BK-IN 01 UP
02 P.AMP/ATT 02 DOWN
03 NOTCH 03 UP (VFO: kHz)
04 NB 04 DOWN (VFO: kHz)
05 NR 05 VOL UP
06 SPLIT 06 VOL DOWN
07 A/B 07 XFC
08 VFO/MEMO 08 CALL
09 CD 09 VFO/MEMO
10 PRESET 10 DR
11 Home CH 11 FROM/TO (DR)
12 Temporary Skip 12 Home CH
13 Voice/Keyer/RTTY Memory 1 13 BAND/GROUP UP
14 Voice/Keyer/RTTY Memory 2 14 BAND/GROUP DOWN
15 Voice/Keyer/RTTY Memory 3 15 SCAN
16 Voice/Keyer/RTTY Memory 4 16 Temporary Skip
17 SPEECH
18 MODE
- [AUTOTUNE/RX>CS/AFC] setting 19 |RF Power
Command: 1A05 00 76 20 Voice/Keyer/RTTY Memory 1
Data Function 21 Voice/Keyer/RTTY Memory 2
00 AUTOTUNE/RX>CS/AFC 22 Voice/Keyer/RTTY Memory 3
01 CD/RX>CS 23 Voice/Keyer/RTTY Memory 4
02 PRESET/RX>CS 24 T-CALL”
03 |Home CH/RX>CS 25 |RX>CS
04 Temporary Skip/RX>CS 26 TS
27 MPAD
28 SPLIT
29 A/B

* Only for European version.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

+ Data mode with filter width settings
Command: 1A 06

® @

0 0
00=Data mode OFF* 01=FIL1
01=Data mode ON 02=FIL2

03=FIL3

*When 00 is set, also set 00 to @.

* Repeater tone/tone squelch frequency settings
Command: 1B 00, 1B 01

@* @ ®
oo | x i x| x i x|
1 ) 1
5 & I 2 <5 2
2 2 5 # L B
2 2 © I B T
'O'OEN-OE
e ¢ s T & C
2 = O O -
L L @~ - - O

*Not necessary when setting a frequency.

* DTCS code and polarity setting
Command: 1B 02

® @ ®
X i X | ' '

0 (fixed) —— | ©

First digit: 0 ~ 7 —>| X
Third digit: 0 ~ 7 ——| X

Second digit: 0 ~ 7 —>| X

— Receive polarity: 0=Normal
1=Reverse

Transmit polarity: 0=Normal
1=Reverse

+ DV Digital code squelch setting
Command: 1B 07

X
e
X

First digit: 0 ~ 9 —>
Second digit: 0 ~ 9 —>

23

* DV MY call sign setting

Command: 1F 00

Set your own call sign and note of up to 12 characters.
See “Character’s code of the call sign.”

(D ~ ®: Your own call sign setting (8 characters)
(9 ~ (: Note setting (4 characters)

* DV TX call signs setting
(24 characters or 8 characters)
Command: 1F 01
Set “UR,” “R1,” and “R2” call signs of 8 characters
(fixed), or only the “UR” call sign.
See “Character’s code of the call sign.”

When setting “UR,” “R1,” and “R2” call signs

(M ~ ®: UR (Destination) call sign setting
(8 characters)

(9@ ~ @®: R1 (Access/Area repeater) call sign setting
(8 characters)

(D ~ @: R2 (Link/Gateway repeater) call sign setting
(8 characters)

When setting only the “UR” call signs

@ ~ ®: UR (Destination) call sign setting
(8 characters)

Character’s code of the call sign

Character | ASCIl code
0~9 30~ 39
A~Z 41 ~ 5A

(Space) 20
/ 2F

* DV TX message setting

Command: 1F 02

Set the transmit message of up to 20 characters.
See “Codes for character entries.” (p. 19)

“FF” stops sending or reading messages.



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* DV RX call sign data

Command: 20 00 01, 00 02
OO0y —@~0-— 0O~@—©6~2
[xx[xix[x:x] - |X:X|X:X|X:X|X:X| o [xix] D
@ ~60 G)~G9
[Xix] o XXX - [xix]
(D: Header flag data (First byte)
Data Description
bit7 | (O: Fixed) —
bité | (O: Fixed) —
bit5 | (0: Fixed) —
bit4 0/1 0=Voice, 1=Data
bit3 0N 0=Direct, 1=Through repeater
bit2 0/1 0=No Break-in, 1=Break-in
bit1 0/1 0=Data, 1=Control
bit0 0/1 0=Normal, 1=EMR

(2: Header flag data (Second byte)

Data L.
bit2 | bit1 | bit0 Description
1 1 1 | Repeater control
1 1 0 |Send auto acknowledge
1 0 1 | (Not used)
1 0 0 |Request to re-transmit
0 1 1 | Send acknowledge
0 1 0 |Receive no reply
0 0 1 | Repeater disabled
0 0 0 |NULL

(3 ~ (19: Call sign of the caller station
(8 characters, fixed)

@) ~ (9: Note of the caller station
(4 characters, fixed)

@5 ~ @: Call sign of the called station
(8 characters, fixed)

@) ~ (0: Call sign of the access/area repeater (R1)
(8 characters, fixed)

@) ~ 38 Call sign of the link/gateway repeater (R2)
(8 characters, fixed)

See “Codes for character entries.” (p. 19)

® FF: When no call sign is received since the transceiver

power was turned ON.
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* DV RX message
Command: 20 0101, 0102

ok Vol ol S Vi
DXX] o XXix] e XX ix]x x|

@ ~ 0: Message (20 characters)

@) ~ @8: Call sign of the caller station (8 characters)

~ 32: Note of the caller station (4 characters)

See “Codes for character entries.” (p. 19)

® FF: When no call sign is received since the transceiver
power was turned ON.

Example: When a Gateway call is received

iy, JM1ZLK calllng from
“p;ﬂ/r ‘ RXRPT2 JP1YIU port A
/Uﬁoca//,,] 05
"4 o
kf ﬁ &
PT1 7D

X
INTERNE"

CALLED

CALLER:
CALLED:
RXRPT1:

Caller’s call sign

Called station call sign

Call sign of the repeater that was accessed

by the caller station

@ If it was a call through a gateway and the
internet, this item displays the gateway
call sign of the repeater you received the
call from.

RXRPT2: Call sign of the repeater you received the

call from

* DV RX Status setting

Command: 20 02 01, 02 02
Data Function Description
bit7 | 0 |(Fixed) —
While receiving a digital voice
. Receiving a signal, select “1.”
2is) /1 voice call (Regardless of DSQL and
CSAQL setting)

bit5 | 0/1 L.alst call When the last ‘(‘:al’ly was finished
finisher by you, select “1.

bita | 0/1 Recelvmg a When the audnlo fone can be
signal heard, select “1.

bit3 | 0/1 Receiving a While Eec:elvmg a BK call,
BK call select “1.

. Receiving a While receiving a EMR call,

bit2 | 0/ | iR call select “1.”
Receiving a w7 —

bit1 | 0/1 | signal other \t’)\l’ﬂi; D;/elzgtd“ 1':,!\" are
than DV 9 '

bito | 0/1 Packet loss Yv,t’w!le displaying packet loss,
status 1” is returned.




REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* GPS/D-PRS data
Command: 20 03 01 00, 01 01, 0102, 0103,

02 00, 02 01, 0202, 0203

Data number and description

Data number Description
00 D-PRS — Position
01 D-PRS — Object
02 D-PRS — Item
03 D-PRS — Weather
Position
Command: 2003 0100, 0200
D~@— ©® O —@~®—
[0fo]xix] - [XiX[xix[xix|xix] - [xiX]
_Data number 7
©~@ B-®— @

DX o XXX e DX XXX
—®-9 D-B®—
DX e DixDx] e xix]xex|xix|xixxix|

@ ~®: Call sign/SSID

(9 ASCII characters (A~Z2,0~9, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
Latitude (dd°mm.mmm format)

: Longitude (ddd°mm.mmm format)

: Altitude (0.1 meter steps)

Course (1 degree steps)

Speed (0.1 km/h steps)

Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

l-
2?

1§

8

1§

CISISISISICIE
l§ 1§
B ®®

~ ®: See the table below.
Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)

00 0 3/10 0 Omni-direction
01 1 6/20 1 45° NE
02 4 12/40 2 90° E
03 9 24/80 3 135° SE
04 16 49/160 4 180° S
05 25 98/320 5 225° SW
06 36 195/640 6 270° W
07 49 390/1280 7 315° NW
08 64 780/2560 8 360° N
09 81 1561/5120 9 —

@® The item, that is not contained the received data, is filled
with “FF.”
@ FF: No signal has been received since the power was
turned ON.
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Object

Command: 2003 0101, 02 01

[0:1]xix]

: Call sign/SSID

(9 ASCII characters (A~Z2,0~9, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
Latitude (dd°mm.mmm format)

: Longitude (ddd’mm.mmm format)

. Altitude (0.1 meter steps)

Course (1 degree steps)

Speed (0.1 km/h steps)

Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

I-
2?

1§

8

1§

CISISISISICIO
1§ 1§
B9 8®®

~ @: See the table below.
Power Height Gain Directivity
Data (W) (m/ft) (dB) (deg)
00 0 3/10 0 Omni-direction
01 1 6/20 1 45° NE
02 4 12/40 2 90° E
03 9 24/80 3 135° SE
04 16 49/160 4 180° S
05 25 98/320 5 225° SW
06 36 195/640 6 270° W
07 49 390/1280 7 315° NW
08 64 780/2560 8 360° N
09 81 1561/5120 9 —
~6): Name
(9 ASCII characters (00h ~ EFh))
62: Type (01= Live, 00= Killed)

@® The item, that is not contained the received data, is filled
with “FF.”
@ FF: No signal has been received since the power was
turned ON.



REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* GPS/D-PRS data (Continued)

Item

Command: 2003 0102, 02 02

[0:2]xix]

C/—.T.@—\@ ® ®
|xzx|xzx|xzx|xzx|xzx|j

. Call sign/SSID
(9 ASCII characters (A~27,0~09, /, -, space))
Symbol (2 ASCII characters (00h ~ EFh))
Latitude (dd°mm.mmm format)
: Longitude (ddd’mm.mmm format)
. Altitude (0.1 meter steps)

Course (1 degree steps)

I-
2?

1§

S EEE
l
e

~@D: Speed (0.1 km/h steps)
~ (39: See the table below.
32 Power | 33 Height Gain | 69 Directivity
Data (W) (m/ft) (dB) (deg)
00 0 3/10 0 Omni-direction
01 1 6/20 1 45° NE
02 4 12/40 2 90° E
03 9 24/80 3 135° SE
04 16 49/160 4 180° S
05 25 98/320 5 225° SW
06 36 195/640 6 270° W
07 49 390/1280 7 315° NW
08 64 780/2560 8 360° N
09 81 1561/5120 9 —
~ @: Name
(9 ASCII characters (00h ~ EFh))
@: Type (01= Live, 00= Killed)

® The item, that is not contained the received data, is filled
with “FF.”
@ FF: No signal has been received since the power was
turned ON.
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Weather

Command: 2003 01 03, 02 03

[0:3]xix]

X

M ~@: Call sign/SSID

(9 ASCII characters (A~Z,0~9, /, -, space))

Symbol (2 ASCII characters (00h ~ EFh))

Latitude (dd°mm.mmm format)

Longitude (ddd°’mm.mmm format)

Date (UTC: yyyymmddHHMMSS)

(y: Year, m: Month, d: Day,

H: Hour, M: Minute, S: Second)

Wind direction (1 degree steps)

Wind speed (0.1 m/s steps)

Gust speed (0.1 m/s steps)

: Temperature (0.1°C steps)
Temperature (00= + degree, 01= — degree)
Rainfall (0.1 mm steps)
Rainfall (24 hours) (0.1 mm steps)
Rainfall (Midnight) (0.1 mm steps)
Humidity (1% steps)

@9: Barometric pressure (0.1 hPa steps)

1§

SISICIE
1§ 1§ @
PRS-

; -

PPPePRRE®E®
SISIEIS é@@@

@® The item, that is not contained the received data, is filled
with “FF.”
@ FF: No signal has been received since the power was
turned ON.

* GPS/D-PRS message
Command: 20 04 01, 04 02

O~ ©@—,—00~6—
x| - [xix[xix] - - - [xiX]
(Variable length)
@ ~ @: Call sign/SSID
(9 ASCII characters (A~ Z,0~9, /, -, space))
~ 62: Message
(Up to 43 ASCII characters (00h ~ EFh))

@ FF: No signal has been received since the power was
turned ON.




REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

* RIT frequency settings » Selected or unselected VFO frequency settings
Command: 21 00 Command: 25
| x : x | x i x| x i X [XIX[xIx[xEx[x X[ x x[x(X]

T T T g L I I

o S 1 00=Selected VFO Operating frequency

c1> 0? cl) o 01=Unselected VFO See “Operating frequency.” (p. 16)

L. o .. N

T N 2:’: g 00: + (plus) ® When using the DR function, the transceiver returns

= - = = 01: — (minus) “FA” (NG) because these cannot be set to 01.

* When VFO Ais selected
+ DV TX data 00=frequency of VFO A changes
Command: 22 00 01=frequency of VFO B changes
* When VFO B is selected
...................... Q= _
; 00=frequency of VFO B changes
KR o 01=frequency of VFO A changes
(Variable length) q Y 9

(D ~G0: TX data (Up to 30 Byte) + Selected or unselected VFO’s operating mode
@ “FA” to “FF” are entered after converted to “FF OA” to “FF and filter settings

OF” automatically. Up to 60 Byte data can be entered in Command: 26

this case.

Both data and filter settings can be skipped. In that
case, “DATA OFF” and the default filter setting of the
« DV RX data (transceive) operating mode is automatically selected.

Command: 22 01 01 )
(@Data mcide setting

(D ~ 60: RX data (Up to 30 Byte) —
® “FA” to “FF” are entered after converted to “FF 0A” to “FF :

OF” automatically. Up to 60 Byte data can be entered in :
this case. Iy Iy
T (DOperating mode setting (Filter setting
00=Selected VFO
01=Unselected VFO

* MY position data

. ® When using the DR function, the transceiver returns “FA”
Command: 23 00 (NG) because these cannot be set to 01.
/_®~@ V. ©-~-0 V- ®~@_\ « When VFO A is selected
DXEX] e [)EX]XEX] e [XEX]XEX] e XX ) 00 = operating mode of VFO A changes
01 = operating mode of VFO B changes
@ — @~ —,— @~ — * When VFO B is selected
|x§x|x§x|x§x| . ]X§X|x§x| o |X§x| 00 = operat!ng mode of VFO B changes
""""""" 01 = operating mode of VFO A changes
®~G: Latitude (dd*mm.mmm format) (D Operating mode | (@ Data mode @ Filter
® ~ @): Longitude (ddd°mm.mmm format) setting setting setting
@~ ©: Altitude (0.1 meter steps) 00.LSB  |07:CW-R |00: Data mode OFF*? | 01:FIL1
@, @D:  Course (1 degree steps)
~@: Speed (0.1 km/h steps) 01:USB 08:RTTY-R | 01: Data mode ON 02:FIL2
@) ~ @): Date (UTC: yyyymmddHHMMSS) 02:AM 17:DV — 03:FIL3
(y: Year, m: Month, d: Day, 03:CW 22:DD*! — —
H: Hour, M: Minute, S: Second) 04:RTTY |23:ATV* _ _
05:FM — — —

*1 The commands can be set when the 1200 MHz or higher
band is selected.
*2 \When 00 is set, also set 00 to 3.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

» Scope waveform data
Command: 27 00
Outputs the waveform data to the controller (PC).

O 2 @@ ® —0— ® —O0

050 XX XX XX XX X x| XX XX XX

: 00 (Fixed)
(2: Order of division data (Current): 01~11
(3: Division number (Maximum): 01(LAN), 11(USB)
® When data is sent to the controller (PC) using the
[LAN] port, all data is sent together. However, when
the data is sent through the [USB] port, the data is
divided by 11 and sent in sequential order.
® The 1st data sends only the wave information (D
~ ®) without the waveform data (). The 2nd or
later data sends “00” (D), the order of division data
(Current) (@), the division number (Maximum) (3®),
and the waveform data ().

@: Spectrum scope mode data:
» 00 = Center mode scope
* 01 = Fixed mode scope
* 02 = SCROLL-C mode scope
* 03 = SCROLL-F mode scope

®: Waveform information:
The waveform information differs, depending on
the Spectrum scope mode.
* In the Center mode:
Center frequency and span are sent.
See page 16 for Operating frequency data,
and the Scope span settings (2 ~ ®).
® When the 5600 MHz or lower band is selected, the
Center frequency is 10 digits (5 bytes).
When the 10 GHz band is selected, the Center
frequency is 12 digits (6 bytes) from 100 GHz to
1 Hz.

* In the Fixed, SCROLL-C, and SCROLL-F modes:

Lower edge and higher edge frequencies are

sent.

See the Scope Fixed edge frequency settings 3

~ (% on page 29.

® When the Higher Edge or Lower Edge frequency is
in the 10 GHz band, the each Edge frequency is 12
digits (6 bytes) from 100 GHz to 1 Hz.
When the Lower Edge frequency is negative, the
100 GHz digit is set to “F,” and the other than 100

GHz digit are set to absolute value of the frequency.

(®: Out of range information:
* 00 =Inrange
* 01 = Out of range
@ If the scope data is out of range, the waveform data
(@) is omitted.

@: Waveform data:
The transceiver outputs the drawn waveform data.
The data range or data length of the waveform
data is judged by the controller (PC). (The data
range is basically the same as the display size of
the scope on the controller (PC).)
» Data range: 00 ~ A0 (0 ~ 160)
» Data length: 475

* Scope span settings
(in the Center mode and SCROLL-C mode Scope)
Command: 27 15

o @ ® ® 6 ® Span (kHz)
l0:0]oio|xix|xix|xix|o:0] 2500| 25
T T 4 T T T Ti 5000 5
© 3
=1 NERE 10000 10
E2Rw .~ xb 25000 25
LX§N .0 g Lo
cL3SZSSoox 50000 50
15222552587 100000| 100
88525 N NNTTI 250000| 250
X xXxNONTxTIPPS
LCLINIT oo X235 5o
so2-iggeee e 500000| 500
1000000 1000
2500000 2500
5000000 5000
10000000 | 10000
25000000 | 25000

» Scope Reference level settings
Command: 27 19

[o:o[xix[xi0]0 x]
t— T l T 00= + (plus)
S ? d?.: 01= — (minus)
= @ £ o

5528532

% °5 w33

el ° o}

ir iL © m - X%

— = o ©° <. QT

O O v« v O O

Adjustable range: —20.0 dB ~ +20.0 dB
in 0.5 dB steps.
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REMOTE CONTROL

Remote control (CI-V) information

¢ Command formats

» Scope Fixed edge frequency settings
Command: 27 1E

©® 2 66 ® 6 6 0 6® @ O @ @
|o§x|05x|x§x|x§x|x'x|x'x|x§x|x§x|x§x|x§x|x'x|x'x|

. m m 0o ol g lvo
o, o o o, o Nt
8 S ol 1% calar 7 12 2o
e L 1921 0%9c0lT 192109000
i 1 ococxE 1 =9 LoocE
S § olo .= i 50 Lo = o >
= O L EoOEGiL 2.0 _  EOoE5E oo
T E D50 202D Do o200
€ S o5 NS ToPgso5°N0 (TOY
o c O 2B NT NN IS 2o NT NN I
S ¢ NONTxTIPRESNONTTIPRES
g oL NI coX¥25s50 T oo>¥25m0
¢ 5§ oTX¥X3383002098cTX¥X5800=293
L L mrmrmr mrmrmrmrrmrrrrrrvrT T T T o
Lower edge Higher edge

® Entry of less than 1 kHz digits are ignored.
® When “06” is selected in O, the each Edge frequency is
12 digits (6 bytes) from 100 GHz to 1 Hz.

26 ®6 606 e oo 6 @
|0:6]0:ix|x:xx:x|xix[x:xxix] 0:x[x:x|x:x|x:x[x:X|xix| 0]

O —_ —_

: 3 k3
q) ~
o © o 0T E ool E
e . o551 EL ©,0%551 EL
§ o 1 { ol o, 2 {

@ t co . ] co .
- T ol 773191 590l "o
> ? CLocEE Sl PP ocEE
o E °o S22 ST DoEC SO uHoE o i
c 3 =7 oD2E5ET 0.0 £ os o255T 0.2
¢ c o S22 T OEDS 0% 022y NDO
o> © ©°2 NNOOTINTS 20 R yNTTI TN
o O N7 TINNSOINONTTINNSOIL
oIy ¥§§£OOOI£IOO¥§§5006

o o o ool o) xOOOO o OO
N A ST
Lower edge Higher edge

(D Selectable Frequency ranges:

Data | Frequency range (unit: MHz)
01 144.000000 ~ 148.000000
02 430.000000 ~  450.000000
03 1240.000000 ~ 1300.000000
04 2300.000000 ~ 2450.000000
05 5650.000000 ~ 5925.000000
06 | 10000.000000 ~ 10500.000000

(2 Selectable Edge number: 01=1, 02=2, 03=3, 04=4
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